
© Copyright 2021 HP Development Company, L.P. The information contained herein is subject to change without notice. 

How to create window 
graphics with the HP 
Latex 700 and HP Latex 
800 Printer Series 
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This document will explain how to print on clear 

substrates—either self-adhesive vinyl or polyester 

films—to create window graphics.

A deep-dive training about window graphics on the 

HP Latex 700/800 Printer series is available in the 

Learn App from your PrintOS account. See more 

details in this article.

https://learn.www.printos.com/#/Learn/Courses/:all?courseid=8506
https://hplatexknowledgecenter.com/blog/printos-learn-central-learning-platform-your-print-organization
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What you will need
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How to create window graphics

Clear self-adhesive vinyl 
or polyester film

Transfer tape (optional)

SW tools
(RIP, editor, etc.)

PrinterWhat you will need

Preparing the substrate

Preparing the job

The printing process 

Before 
printing

Printing

After 
printing

Film laminator (optional)Film laminate (optional)

Weeding tool (optional)

Cutting device -

HP Latex Cutter Plus

Post-print finishing

Installation

Plastic squeegee with 
low-friction sleeve

Water or installation 

fluid (optional)
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Preparing the substrate
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By raw material

• Calendered monomeric 

• Calendered polymeric

• Cast vinyl

• PVC-free substrates

• Polyester films (PET)*

1. Types of clear self-adhesive films

What you will need

Post-print finishing

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

3. Substrate presets

By surface finish

• Transparent gloss

• Transparent matte

• Frosted

By adhesive type (clear for window 
graphics)

• Permanent

• Removable

• Cling (adhesive free)

• Normally, Clear Vinyl provides an economical solution while Clear PET has a higher transparency.

• For mid- and long-term uses or high-transit areas, it is recommended to protect the graphics with film lamination.

2. Usage

Installation

• Check that the material you are going to use has its own substrate preset:

a) On the web, in the HP PrintOS Media Locator: www.printos.com/ml/#/medialocator

b) On the printer’s front panel online search (Substrate Library)

c) On the web, from the substrate vendor’s or RIP vendor’s websites

• Download and install.

TIP: Learn how to customize your profile by enrolling on 
the available training: “HP Latex 700/800 Printer series –
Advanced main tasks and maintenance routines” on the 
Learn with HP website.

NOTE: If you cannot find the substrate presets, you can always use 
the generic presets for transparent self-adhesive vinyls or 
transparent polyester films already installed in your printer. If you 
need to fine-tune some settings, clone the existing generic preset 
and modify it, or create a new one with the Add new substrate 
function on the front panel.

How to create window graphics

IMPORTANT NOTE: Clear PET’s are generally available with 2 types of coating: a) for UV inks and b) for Solvent inks. Latex inks 
are mainly compatible with PET’s with coatings for Solvent inks. We cannot guarantee full compatibility with PET’s for UV inks, 
especially when they’re applied following the wet technique. 

http://www.printos.com/ml/#/medialocator
https://learn.www.printos.com/#/Learn/Courses/:all?courseid=7682


© Copyright 2021 HP Development Company, L.P. The information contained herein is subject to change without notice. 

Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

How to create window graphics

Post-print finishing

Installation

Measure the size of the window and adjust the graphic to 
that size. If covering a window from edge to edge, leave a 
2-3 cm  excess margin on each edge. 

2. Big windows

3. Sign-installation side

When more than 1 piece of film is needed, adjust the 
image to allow 2-3 cm overlap between the different tiles 
that compose the whole image.

A. If sign installation is done indoors and the 
sign is viewed from outdoors, the image 
needs to be mirrored and the white print 
mode selection should be overflood or spot.

B. If installation and viewing side are outdoors, 
the image does not need to be mirrored and 
the white printmode selection should be 
underflood or spot.

C. In both situations (A or B), if the image has to
be viewed from both sides, then the white 
printmode to use is sandwich mode.

TIP: Play with different amounts of white ink density to modify the opacity of the white layer and its light diffusion capability.

1. Measure the window
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Preparing the job
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Tools such as HP Applications Center (HP Signage Suite apps), Adobe Illustrator, 
Photoshop, and InDesign help you design and edit jobs and adapt them to your needs.

1. Software for designing and editing

What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

You can use several tools to create the white ink layer in your image: 

1. Using  Adobe - it permits you to allocate the white ink on all the desired places of your image. 
2. Using the RIP - it is a more simple and easy way but offers fewer design options.

A. HP Signage Suite

2. Create White ink layers

How to create window graphics
Make your decision 

based on your 
needs

HP Signage Suite is part of HP Applications Center, a complete package of tools to boost your business

1 2 3

Join the platform
Simple, easy sign-in 
with your HP printer 

serial number.

Choose a web app
Select the standalone decorative 
web apps you want to produce 
with and allow your customers 

to create and visualize the 
design with a simulation for 
each unique environment.

Manage orders
Manage production 

efficiently with automatic, 
reliable, print-ready PDF 

generation, as well as 
customer, order, and 

content management tools.

How does it work?

EXPAND YOUR KNOWLEDGE: For further detailed information regarding HP Applications Center and how to log in for the first 
time, check out the webinar available at this link!

Post-print finishing

Installation NOTE: To work with white ink layers, learn how to create one with Illustrator and Photoshop by enrolling in the available training: 
“HP Latex 700/800 Printer series - White ink” on the Learn with HP website, or also refer to the cookbook How to print on white.

https://hp-gsb.docebosaas.com/learn/course/7406/play/24522/hp-application-center-lite
https://learn.www.printos.com/#/Learn/Courses/:all?courseid=8055
https://hplatexknowledgecenter.com/applications/how-print-white-ink-hp-latex-r-series-printer
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Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

• Create a new color swatch

• Assign an identifiable name, e.g. CutContourKiss

• Select color type: Spot Color

• Create the cutting path with that color swatch

How to create window graphics

A. Using Adobe Illustrator 

Post-print finishing

Installation

B. Using SAi HP Flexi Print and Cut Editor TIP: To avoid cutting inaccuracies, 
add bleed to the contour line where 
the cutting path goes, so the cut 
will not fall in undesired areas

Make your decision 
based on your 

needs

2. Add the Contour Cut
From the Effects tab in 

the menu bar

1. Select the path
It will be highlighted in the Design 

Editor window

3. Specify Contour properties
From the Design Central window. 

Select the color and click Apply

3. Add contour cut paths for automatic cutting 
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Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

ONYX, Caldera, and SAi RIPs have been certified for HP Latex 700/800 series printers.

All these RIPs have specific options for job editing.

• Choose the substrate type (Generic Transparent Self-adhesive Viny or  
Generic Transparent Polyester Film), then select the specific substrate 
you have loaded on the printer.

• Next, choose the printmode. There are several printmodes that are 
available to choose from based on how the white ink is placed.

A. Substrate & Printmode selection

How to create window graphics

Post-print finishing

Installation

NOTE: More information on 
how to print with Sandwich 
mode here: How to Print 
Sandwich Mode

Make your decision 
based on your 

needs

NOTE: Before selecting the substrate in the RIP, it must be loaded on the printer

4. RIP processes

Underflood Mode
Select this mode on
substrates installed and
viewed from the same side
(generally outdoors). In
this mode, a white ink
layer is printed first and
then a color layer is
printed on top of it.

Sandwich Mode
There are 2 Sandwich modes
to choose from depending on
the application’s need:
Sandwich 3 Layers (also
known as 3L) for day and
night applications, and
Sandwich 5 Layers (also
known as 5L) for dual-sided
applications

Spot Mode
Select this mode to print
images where white is not
mixed with other colors in
the same area and/or
printed with only white.

Overflood Mode
Select this mode on
substrates applied on one
side and viewed from the
other side (generally applied
indoors and viewed from
outdoors). In these modes a
color layer is printed first and
then a white layer is applied
on top.

• You can also choose the white ink
levels depending on the desired speed,
opacity and available printmodes

W60

W100 

W160 

https://lkc.hp.com/blog/how-rip-and-print-sandwich-mode-latex-700w-and-800w
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Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

How to create window graphics

Post-print finishing

Installation

Make your decision 
based on your 

needs
Choke is used to shrink the white layer if there is a misalignment between the color 
layer and the white layer in the printed output, such as in the examples below.

• By default, the RIP applies a 
default value of 3 pixels for 
choke.

• If a different value is required, you 
can modify the value in the RIP.

ONYX
In the job queue:

1. Right-click on your job.

2. Select Edit > Printer 
Settings.

3. Check White choke control.

4. Adjust the number of pixels
you want to reduce.

B. The Choke functionality

4
3

2
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Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

Post-print finishing

Installation

Caldera
1. Open your printer options menu.

2. Click on Specific settings for printer
(wrench icon).

3. Under the Advanced parameters menu, 
select Smart Chokes and adjust the pixel 
amount that needs to be reduced.

SAi
In the job properties menu:

1. Click the Printer Options tab.

2. Select Smart Chokes and adjust the pixel 
amount to be reduced.

2

How to create window graphics
Make your decision 

based on your 
needs

1

3

2
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Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

Post-print finishing

Installation

ONYX
In the job queue:

1. Right-click on your job.

2. Select Edit > Printer Settings.

3. Click Optimize for lamination.

Caldera
1. Open your printer options menu.

2. Click on Specific settings for printer (wrench icon).

3. Under the Advanced parameters menu, select 
Optimized for lamination.

SAi
In the job properties menu:

1. Click the Printer Options tab.

2. Select Optimize for lamination.

3

2

3

2

How to create window graphics
Make your decision 

based on your 
needs

1

C. Option to optimize lamination
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Preparing the job
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

Some specific settings are required to work with substrates such as:

A. Select printmodes

• Select a white printmode:            
UF, SP, OF or SW of W100 density

C. HP barcode

• Select the OPOS desired and HP 
barcode

• Select Add white background

How to create window graphics 4. Tips for Print&Cut jobs with white ink on special substrates - SAi

Post-print finishing

Installation

B. Color separation

• Select the Channel Spot1
• Edit
• Select Print as White

A

D. HP barcode

• OPOS and HP barcode are printed 
with white borders so they can be 
read by the OPOS sensor

Color substrates Transparent substrates 
with transparent linersMetallized substrates

C

B D
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The printing process
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Prepare the TUR
Attach an empty core on the TUR.

Move substrate
Advance the substrate until the leading 
edge levels with the TUR.

2.

Release substrate from pinches
• Lift the pinchweels.

• Align the right edge of the substrate 
with the right edge of the input roll.

• Tap Done in the front panel to lower 
the pinchwheels.

3.

Attach substrate to the TUR (optional)
You can attach the substrate so that the 
printed side is in (a) or out (b) (out is the 
most common).

4.

Activate the TUR
Complete a full rotation of the TUR.5.

Calibrate the TUR
Select Calibrate on the front panel.6.

1.

What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

TIP: For long jobs, connect the substrate to the take-up-reel (TUR). For tiling applications, connect the TUR before starting to print.

a) b)

How to create window graphics Loading substrate | Connecting to the take-up reel (TUR)

1 2

3 4

5 6

Post-print finishing

Installation
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The printing process
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Load the substrate roll
By default, this is in automatic mode.

Select the right substrate preset
If your substrate is new, select the type 
(Generic Transparent Self-adhesive vinyl or 
Generic Transparent Polyester Film).

2.

Calibrations
• Color calibration is not supported for 

transparent substrates.
• Perform advance calibrations. 

3.

Send the job to print from the RIP
• Click Send to print.

5.

Cut & retrieve the printed roll
This can be done in automatic mode or manually.6.

1.

What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

TIP: Before cutting the printed job, advance the substrate so that you protect the printed roll when it is unloaded.

How to create window graphics

Post-print finishing

Installation

NOTE: Perform the printhead nozzle check and printhead alignment on white self-adhesive vinyl before loading a 
transparent film with transparent liner.

Loading Position
Normally, transparent films can be printed from 
the pinches, but some films may need to be 
positioned after the curing zone or even be 
attached to the TUR to avoid a substrate crash.
For Transparent vinyls, the TUR is recommended.

4.

NOTE: In cases where you are loading very 
thin films, you might need to load them 
manually with the help of the loading accessory.

2

5 6

4 4

3 3

1
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Post-print finishing
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To cut the graphics automatically, you can use XY cutters or flatbed contour cutters.

The “Kiss cut” cutting type will be the most common, but on some occasions, a “cut through” can be added to separate 
each sticker.

2.Cut

Use the film laminate recommended by the film manufacturer.

Follow the lamination settings (speed, pressure, and temperature) specific for the SAV+laminate combination.

What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

TIP: Remember to select a printmode with NO overcoat when you 
are going to be laminating your job later, or check the option 
“Optimize for lamination” in the RIP’s printer settings.

Post-print finishing

Installation

IMPORTANT!: Recommended for long-term usage, high-transit 
areas, and surfaces that will be cleaned frequently.

How to create window graphics

Sticker with cut throughWeeding after a kiss cut
New HP Latex Cutter Plus 

1. Lamination (optional)
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Print calibration boxes (3x3 cm) in black 
(100 CMYK) and white (Spot W100) on 
the substrate for your print&cut jobs. 

Post-print finishing
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

TIP: Perform all the 
necessary calibrations on 
your cutter before 
continuing with your 
print&cut job. For further 
information, check the HP 
Cutter user guide.

Post-print finishing

Installation

IMPORTANT!: The 
unattended workflow will 
not work with the HP 
barcode with a white 
background. After the first 
job is cut, you will have to 
position the OPOS sensor 
just below the HP barcode 
of the next job.

How to create window graphics
A. Load the plot correctly

B. Calibrate media (OPOS)

On the cutter’s front panel, tap: 
Calibrations > Calibrate media (OPOS).
Follow the front panel instructions; you 
will be asked to position the OPOS 
sensor above each color patch, including 
the non-printed area.

Position the plot so that the first pinch 
partly rolls over the white part of the HP 
barcode (see picture).

3. Cutting special medias – white ink OPOS

http://h10032.www1.hp.com/ctg/Manual/c07014509.pdf
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Installation
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

How to create window graphics

Post-print finishing

Installation

• Dust particles present on the glass will cause a visible bubble in the film.

• Clean the window using a specific window cleaner or soapy water. Use a window scraper to remove adhered dust 
if needed. Remove the water using a rubber squeegee and a lint-free cloth.

• Pay extra attention to the dirt present on the window glass edges and frame.

3. Clean the window

• Handle samples with care! It is recommended to use gloves to 
prevent leaving fingerprints on the surface. We recommend rolling 
the printed samples on the outside of an empty core to prevent 
leaving accidental folding marks.

• Follow media vendor instructions to protect and store rolls.

• In case of wrapping windows from edge to edge, pre-cut samples 
leaving 2-3 cm margins on the edges close to the window frame.

• In case of contour cuts, cut the samples to its final dimensions, 
leaving 2-3 cm margins on the edges close to the window frame.

2. Pre-Cut samples

1. Handling Samples
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Installation
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

How to create window graphics

Post-print finishing

Installation

a. Place the sign on the window, without 
removing the liner yet, and with the 
help of a bubble level, place the sign in 
its final position.

b. Apply 2 pieces of tape to fix the sign in 
its position.

c. Carefully cut the tape on the edge of 
the sign with a sharp cutter. Do not 
apply pressure in order to not scratch 
the glass. The tape left on the window 
will be used as reference together with 
the tape on the sign.

d. Align the 2 pieces of tape to ensure 
proper registering and apply the sign.

4. Registering the sign’s position

a b

dc

5. Remove the liner

a. Remove the film’s liner on a clean surface. When removing the liner from 
the printed film, static charges may be created and some dust may adhere 
to the adhesive. In order to prevent the dust from adhering, spray soapy 
water on the exposed adhesive while the liner is being removed.

TIP: To remove the liner easily you can use 2 pieces of tape adhered on 
both sides of the sign. Place those pieces on a corner and pull them away 
from the sign.

NOTE: If sign is applied using the wet technique, ensure that you use a 
substrate with a solvent adhesive. Water-based adhesives may leave a milky 
finish when they come in touch with water.
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a. Spray water on the center of the 
window, trying not to wet the window’s 
edges.

b. Place the sign in its final position using 
the registers previously marked. In case 
the film is adhering to the window, 
spray some more water on the window.

c. With the help of a soft squeegee, 
remove the water, moving the 
squeegee from the center to the edges 
of the sign. 

Installation
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

How to create window graphics

Post-print finishing

Installation

TIP: For lettering jobs, use transfer tape for 
perfect placement of each piece. 

6. Apply the sign

With the help of a 5-way tool or with a long squeegee, press the excess 
of film to the edge of the window frame. 

Place the 5-way tool or the long squeegee between the cutter and the 
window edge. Use the 5-way tool as a guide to cut the excess of film.

7. Cut to final size

NOTE: Following this step, the film won’t touch the edge of the window, and 
this space will become almost unnoticeable.
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Installation
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What you will need

Preparing the substrate

Preparing the job

The printing process

Before 
printing

Printing

After 
printing

How to create window graphics

Post-print finishing

Installation

Spray some soapy water on the installed sign and re-squeegee it 
until removing the excess of water that might remain between 
the window and the sign.  

9. Cleaning

During the life of the sign, it will probably be needed to clean the 
window and the sign. We recommend cleaning it with soapy water and 
a soft cloth. We do not recommend use aggressive, alcohol-based 
cleaners to clean the sign.  

In case of using multiple panels, follow the same steps. Allow 2-3 cm 
overlap between the different tiles that compose the image.

10. Signs with multiple panels

8. Re-squeegee the sign
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Remarks
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• High opacity true white, without yellowing over time.
• High flexibility white with strong scratch resistance.
• Automatic white maintenance & low waste solution.
• The new HP Latex inks are ideal for safe indoor applications. The newest HP Latex Inks are UL ECOLOGO and UL GREENGUARD 

GOLD certified, and conform to the Zero Discharge of Hazard Chemicals (ZDHC) manufacturing restricted substances list v1.1.
• We recommend protecting your prints with film lamination for long-term usage and high-transit areas. 

Learn more at:

• HP Latex Knowledge Center

• Learn with HP

In partnership with:

Certifications:
1Zero Discharge of Hazardous Chemicals. Applicable to HP Latex Inks. The ZDHC Roadmap to Zero Level 1 demonstrates that an ink conforms to or meets the standards of the ZDHC Manufacturing
Restricted Substances List (ZDHC MRSL) 1.1, a list of chemical substances banned from intentional use during production. ZDHC is an organization dedicated to eliminating hazardous chemicals and
implementing sustainable chemicals in the leather, textile, and synthetics sectors. The Roadmap to Zero Program is a multi-stakeholder organization which includes brands, value chain affiliates,
and associates, that work collaboratively to implement responsible chemical management practices. See roadmaptozero.com.
2Applicable to R Series and 700/800 Printer series HP Latex Inks. UL ECOLOGO® Certification to UL 2801 demonstrates that an ink meets a range of multi-attribute, lifecycle-based stringent criteria
related to human health and environmental considerations (see ul.com/EL). HP is the only printing company with UL ECOLOGO® Certified inks in the “Printing Inks and Graphics Film” product
category, see spot.ul.com/main-app/products/catalog/.
3Applicable to HP Latex Inks. UL GREENGUARD Gold Certification to UL 2818 demonstrates that products are certified to UL’s GREENGUARD standards for low chemical emissions into indoor air
during product usage. Unrestricted room size—full decorated room, 33.4 m2 (360 ft2) in an office environment, 94.6 m2(1,018 ft2) in a classroom environment. For more information, visit ul.com/gg
or greenguard.org.

 

Level 1- Zero Discharge of 
Hazardous Chemicals (ZDHC)1

 

Inks meet stringent 
health and 

environmental criteria2

 

Unrestricted, full room. 
No-wait installation or 

lamination3

How to create window graphics

https://hplatexknowledgecenter.com/
https://hp-gsb.docebosaas.com/learn
http://www.roadmaptozero.com/
http://ul.com/EL
https://spot.ul.com/main-app/products/catalog/
http://www.ul.com/gg
http://www.greenguard.org/
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